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1.Mapa mugikorrak Interneten

Mapa mugikorrak ezagunak egin dira Interneten 2005eko martxoan Googlek bere Google
Maps zerbitzua aurkeztu zuenetik.

Ordurarte Interneten mapak modu dinamikoan aurkezteko aukera bakarra WMSa zen.
Estandar honi esker, datubase batean dauden datu geografikoak erabiltzaileak eskatzen
dituen unean adierazten dira mapa grafiko batean. Honen adibide ugari dago oraindik

sarean, adibidez http://b5m.gipuzkoa.net/kaletegia/eibar/otaola_hiribidea/001
Google Maps

Googleren berrikuntzaren funtsa, irudiak modu estatikoan zerbitzatzean izan zen. Hau da,
WMS edo antzerako zerbitzu baten bidez sortutako irudiak koadro edo “tile”-tan prestatu eta
zatituta izatea, erabiltzaileak JavaScript bidezko liburutegi batzuei esker.
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Google Mapseko koadro bat, 256x256 pixeletakoa

Berrikuntza hau Googlek zabaldu zuen mundura eta ordutik de factoko estandar bihurtu da
sistema hau edozein mapa erakusteko moduan.

Bisitatu eta aztertu gertutik Googlemaps-en funtzionamendua: http://maps.google.com/
Yahoo eta beste askoren mapa sistemekin alderatzen baduzue ikusiko duzue denak
dabiltzala sistema antzerakoaz, hau da, koadro edo tile-etan zatitutako irudien sistemekin.

Baina Goooglek eta bere mapa zerbitzuek ekarri zuten berrikuntza handienetakoa mapak
norberaren webgunean jartzeko aukera izatearena izan zen, beraien Google Maps APlari
esker. APl edo aplikazioak programatzeko interfaze honi esker izugarri zabaldu dira
Googleren mapak sarean eta gaur egun oso arrunta da honelako mapak edozein
webgunetan aurkitzea.

OpenLayers

Googleren mapak webgune batean ikusi ahal izateko Googleren JavaScript kode liburutegiak
erabili beharra dago derrigorrez. Zenbait lan egin dira Googletaz aparte liburutegi horiek
prestatuta izateko, eta horien emaitza OpenlLayers izan da.


http://b5m.gipuzkoa.net/kaletegia/eibar/otaola_hiribidea/001
http://maps.google.com/

OpenlLayersi esker, gure zerbitzari batean mapa bat osatzen duten koadroak zerbitu
ditzazkegu. Google Maps bezala, JavaScript liburutegi bat da eta edozein webgunetan erabili
daiteke, beti ere beraien beraien BSD lizentzia betez gero.

OSMek OpenLayers erabiltzen du mapa zerbitzari moduan. Kontutan izan behar da koadroak
zerbitzeko Google Mapsek darabilen sistema bera darabilela, eta teknikoki bateragarriak
direla bi sistemak (zenbait moldaketa egin ondoren).

OSM eta errenderizazio desberdinak

Garrantzitsua da ulertzea datuen egitura eta horien errepresentazioa guztiz bananduta
daudela OSM eta honelako beste edozein sistematan. Honek esan nahi du, sistemak azkar
ibili behar badu ezingo ditugula azken uneko datuak eguneratuta izan.

Orduan, alde batetik datuek gehikuntza eta edizioa izango dugu eta bestetik datu horiek
nola interpretatu eta erakusten diren.

Gaur egun datuak erakusteko hiru estilo edo errenderizazio nagusi daude OSMen: Mapnik,
Osmarender eta Cycle.

- Mapnik: irudi kalitate onena duena da hau. Prozesatu eta koadroak sortzen denbora
asko ematen duenez, astean behin eguneratzen dira, asteazkenetan.

- Osmarender: estilo hau zakarragoa da, baina datuak askoz eguneratuagoak azaltzen
dira, batzutan ordu pare batetakoak ere, nahiz eta normalean egun batetik bestera
azaltzen diren eguneraketak.

- Cycle Map: lehenengo aldiz, helburu jakin batetarako sortu da errenderizazio bat. Kasu
honetan datubasetik bizikleta bideak aukeratu eta filtratu, eta horiek dira errenderizazio
honetan erakusten direnak. Garrantzitsua da ulertzeko nola datuak eta horien
errepresentazioa zein mailararte den moldagarria eta nola OSM erabiliz errepide mapa
hutsetatik baino haratago joateko aukera dugun.
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2.0penStreetMapen datu eredua

Nodoak (Nodes)

Oinarrizko datuak dira: puntu bat adierazten dute, latitude eta longitude jakin bat dituen
edozein puntu.

Nodo bat independientea izan daiteke (Herri bat, jatetxe baten kokalekua, iturri bat eta
abar) baina gehienetan bide batetan barneratuta egongo da, forma bat (kurba, azalera itxi
bat edo autobideko zati zuzen bat adibidez) definituz.

Nodo baten oinarrizko atributuak latitudea eta longitudea dira beraz.



Bideak (Ways)

Bideak edo Way-ak, forma jakin bat osatzen duten nodo taldeak dira. Nodoen arteko zatia
zuzen batek osatzen du.

Kurbak osatzeko, nodoak kurba baten modura antolatuko dira beraz, eta way-ak nodoak
batuko ditu.

Nodoen ordena garrantzitsua da, nodoak nola zeharkatzen diren definitzen bait da modu
horretan. Gainera, norabide bakarreko kale eta errepideetan adibidez, nodoen ordenak
definitzen du zein norabidetan pasatu daitezkeen ibilgailuak.

Bideen bidez forma itxiak ere marraztu daitezke. Modu honetan azalerak definitu ahal
izango ditugu, dela lur sail bat, kirol, industria edo beste edozein motatako ingurune itxi bat.
Biribilgune edo errotondak ere modu honetan adierazten dira.

— e

Nodoz osatutako zenbait way edo bide

Atributu edo ezaugarriak (Properties)

Nodo eta bideak ezaugarriekin identifikatuko ditugu. Batetik, nodo eta bide bakoitzak
identifikatzaile bakar bat du, bakarra, automatikoki sortzen denal. Bestetik, erabiltzaileak
nahi beste ezaugarri gehitu ditzazke.

Atributuak gehitzeko modua beti da testu bidezko gako eta balio pareetan. Adibidez
Leizarango autobidearen zati bat atributu hauekin markatuko genuke:

Gakoa Balioa
highway motorway
name Leizarango autobidea
ref A-15
oneway yes
layer 2
Eta jatetxe baten tokia adierazten duen nodo bat balitz:
Gakoa Balioa
amenity restaurant
name Orbe jatetxea

Ezaugarrietaz ari garela azpimarratu behar da, ez dela inoiz a priorizko normatibizaziorik
izan. Hau da, zein gako eta zein balio erabiltzeko unean, erabiltzaileak zuzenean editatzen



hasi direla, ezer zehaztu gabe. Behin zenbait froga egin eta denbora pasatu ondoren,
erabiltzaileen artean eztabaida sortu da, gako hau edo hura hobea dela edo honako edo
halako ezaugarri hori modu honetan editatu behar dela. Eztabaida horien bukaeran OSMren
wikian erabakitakoa idatzi da eta handik aurrera modu horretan lan egiten jarraitu da.

Honek esan nahi du oraingoz zehaztu gabeko ezaugarriak baldin baditugu buruan, ez garela
atzean gelditu behar eta pausoak eman ditzazkegula ezaugarri horiek ere behar bezala
adierazi daitezen.

Izan ere, OSMren hasierako ideia errepide mapak egitea bazen ere, pentsatu behar da
bururatzen zaigun beste edozein erabilerarako moldagarria izan daitekeela, beti ere lantalde
bat osatu eta horren berri eman ondoren.

Bukatzeko, kontutan izan behar da inoiz ez dela ezaugarri bat eman behar errenderizazio
jakin batean ikusi nahi dugun kolore edo estiloan oinarrituta. Bideak kontrakoa izan behar
du, hau da, lehenengo ezaugarria eta gero errenderizazioa, eta ez alderantziz. Honela
jokatuz gero etorkizunean sorpresak izan genitzazke, errenderizazioak oso sarri aldatzen
bait dira.

Erlazioak (Relations)

Erlazioak dira OSMren datu ereduan sortu diren azkeneko elementuak. Oraindik gutxi
erabiltzen dira, baina helburua da mota desberdinetako elementuen taldeak sortu ahal
izatea.

Santiago bideak adibidez, oso bide, errepide eta galtzada mota desberdinak zeharkatzen
ditu. Orduan, Santiago bidea osatzen duten errepide, mendiko bide, kale eta abarrak
klasifikazio bakar batean batu genitzazke, denen artean Santiago bide hori osatzen
dutelarik.

Erlazio bideak hala ere, ikastaro honetatik kanpo utziko ditugu, eta erabiltzaile aurreratuak
izango du frogatu eta egiteko aukera.

3.0penStreetMapen edizioa

Izen-ematea

Lehenengo hartu beharreko lana da izen-ematea. Horretarako sign-up loturan klik eginda
sartuko gara eposta, erabiltzaile izena eta pasahitza ematera.

Datuak eman ondoren, eposta kontsultatu beharko dugu eta hango mezuan ematen den
loturan klik egingo dugu, gure eposta konfirmatzeko.

Potlach edizio tresna

OSMren webgunean dago Potlach tresna, edit fitxaren barnean. Horretarako, webgunean
izena emanda gaudela, bilaketa edo zoom bidez nahi dugun ingurunera gerturatu eta edit
fitxan klik egingo dugu.

Potlach tresna egokia da hasiera batetarako edo zuzenketa txikiak egiteko. Gainera,
zuzenean Yahoo-ren aireko irudiak aurkezten ditu, eta horren gainean marraztu ditzazkegu
errepide, kale eta plazak.
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JOSM editorearen ezarpena

JOSM tresna aurreratuagoa da, Potlachek baino aukera gehiago eskaintzen dituena, baina
deskargatu eta martxan jartzeko ere zailxeagoa da.

OSMren wikian dugu JOSMren orria ( http://wiki.openstreetmap.org/index.php//JOSM ) eta
hortik deskargatu daiteke azken bertsioa, latest loturan dagoena. Komeni da deskarga hau
sarri egitea, bi astetik behin adibidez, eguneraketa erritmo bizia du eta JOSM tresnak.

Deskargatzen jarri eta gure ordenagailuan gordeko dugu. Windows ingurunean nahikoa
izango da bi klik egitearekin. Linux sistemetan java -jar josm-latest.jar instrukzioa
exekutatu beharko dugu terminal batean.

Zuzenean Edit -> Preferences barnera sartu eta munduko bola duen ikonoan klik eginda,
gure OSMko erabiltzaile izen eta pasahitza jarriko ditugu, hortik aurrerako lanak gure
izenean egin ditzagun.

Datuen deskarga

Lehenengo lana, editatu nahi dugun inguruneko informazioa deskargatzea izango da.
Horretarako, errazena OSMren webgune publikoan tokia kokatzea izango da. Gero, view
fitxako lotura hartu eta JOSMra ekarriko dugu. Deskargatu botoiari klik egin eta helbide hori
jarri ahal izango dugu ingurune hori deskargatu dezan.

Hortik aurrera tokian zentratuta gaudenez, leihoan ikusten duguna erraz deskargatu eta
kargatu ahal izango dugu. Kontuz ingurune handiegia hartzearekin, sistemak errorea
emango bait digu.

Konturatu ere, badagoela lastermarkak sortzeko aukera. Modu horretan gure herria edo
ingurunea lastermarketan sartu eta handik aurrera azkar deskargatu ahal izango dugu.

Kontutan izan behar da une berean pertsona desberdinak ibili gaitezkeela toki berean
lanean. Horregatik garrantzitsua izaten da uneoro zerbitzari zentralarekin lan egitea, guk
egiten dugun lana sarri zerbitzarira igo eta besteek egindakoa deskargatuz.

Oinarrizko edizioa

Oinarrizko ediziorako garrantzitsuak dira saguaren erabilerarako aukerak:

- Ezkerreko botoia edo botoi nagusia: ediziorako balioko digu, informazioa gehitu,
aukeratu eta ezabatzeko, unean aukeratuta dugun tresnaren arabera.


http://wiki.openstreetmap.org/index.php/JOSM

Eskumako botoia edo bigarren botoia: klik eta tiraka eginez, uneko ingurunea mugitu

ahal izango dugu, lan egin beharreko ingurunea zentratzeko.

Erdiko erroberarekin zoom maila aldatu ahal izango dugu.

Eta hona hemen pantailan dauden botoi nagusien deskribapena:

Lupa: zoom botoia. Ez da oso erabilia, errobera duten saguekin behintzat.
Selekzio tresna: pantailan dauden elementuak aukeratzeko, gero ezabatu, aldatu edo

mugitu ahal izateko. Toki huts batean klik egin eta tira eginez gero, leiho baten barnean
dauden elementu guztiak aukeratu ahal izango ditugu.

- Marrazketa tresna: tresna honekin nodoak gehitu ahal izango ditugu. Maijuskula
teklarekin batera, nodo bakanak sortuko ditu, bidera lotu gabe.

— Zakarrontzi tresna: edozein elementu ezabatzeko. Lehendik aukeratuta badago, ezabatu
egingo da eta bestela elementuan klik egin beharko dugu ezabatu dadin.

— Azalera tresna: lerro motako bide baten segmentu erdian klik eginez gero, extrusio
modura azalerak sortu ahal izango ditugu. Egokia elementu angelu zuzenak marrazteko

adibidez.
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Atributuen edizioa

Behin markatu nahi dugun elementua aukeratuta dugula, eskumako aldeko Properties
gunean Add botoiari eman eta dagozkion gako eta baloreak eman ahal izango dizkiogu.
Lehenago esan bezala, nahi beste.

Gainera, lehendik kargatuta dauden elementuen atributuak aldatzeko aukera izango dugu
ere, dagokion elementua aukeratzen badugu.

Baina zein atributu gehitu elementueri? Beti ere gogoratuz aukera librea dela, komeni da
gure aurrekoek pentsatu dituzten konbenioak jarraitzea. Horretarako, oinarrizko deskribapen
bat dago http://wiki.openstreetmap.org/index.php/Map_Features helbidean, baina gero,
estatu bakoitzean zerrenda berezitua sortu da,
http://wiki.openstreetmap.org/index.php/Es:Map_Features Espainian eta

http://wiki.openstreetmap.org/index.php/Fr:Map Features Frantzian adibidez.

Bestalde, JOSM tresnak laguntza eskaintzen digu goiko menuko Presets aukeraren azpian.
Hasieran (eta martxa hartzen dugunean ere, seguru) aukera oso erabilgarriak izango dira,
gako eta balio pareak erraz sortzeko aukera ematen bait digu.



http://wiki.openstreetmap.org/index.php/Fr:Map_Features
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OSMren estandarizazioa

Aipatu bezala, komeni da aurreko puntuan ematen diren loturak bisitatu eta erabili
beharreko atributu pareak kontutan hartzea. Horri esker bateragarriak izango dira gure eta
beste erabiltzaileen lanak.

Hala ere, erabiltzaileak proaktiboa izatea eskertzen da, hutsune edo behar berriak egunero
sortu daitezke, eta beste erabiltzaileekin trukatzea oso baliagarria izan daiteke. Horretarako
daude talk izeneko posta zerrendak. Orokorra dago, ingelesez, eta baita gaztelaniaz talk-
es eta talk-fr frantsesez.

GPSen arrastoen erabilera

Baina, nola lortu datuak? Lehenengo pausoa GPSa erabiltzea izan da. Mendirako edo
bizikletan ibiltzeko bezalako GPS arrunt batekin, ibilbide jakin bat egin eta grabatzea izan da
normalena. Horretarako, errepideak grabatzean komeni da autoz (ahal den zentratuen
joateko) eta ahal den abiadura geldoenean ibiltzea. Baina berdin egin daiteke lana
bizikletaz, motoz edo oinez.

GPSarekin grabazioak egiten ari garen neurrian, komeni da argazki makina eta libreta bat
eramatea, eta apunteak hartzea: zein motatako errepidea den, zein norabidetan dabiltzan
autoak, zein izen duen, non hasi eta bukatzen diren kaleak, beste zein elementu aurkitzen
dugun (gasolindegiak, jatetxeak, farmaziak eta abar)

JOSM tresnak GPX formatuan grabatutako arrastoak onartzen ditu. Formato hau da gaur
egunean mota honetako datuetarako estandarrena. Hala ere, kontutan izan behar da GPS
marka bakoitzak bere formato propioak erabiltzen dituela, eta horrek konbertsio lan bat
eskatuko digu.

Konbertsioak egiteko, bi tresna proposatzen dizkizuegu, biak doakoak:

— GPSBabel: GPS datu bihurgailua, edozein formatutik beste edozein formatura
transformazioak egiteko aukerak dituena. Puntu asko ditugunean sinplifikazioak ere
egiten ditu. Windows ingurunean tresna grafikoa da eta Linuxean komando lerrokoa.

- EasyGPS: Windowserako tresna sinplea. Gauza gutxi egiten ditu baina oso erraz. la
edozein GPS markarekin lotzen da zuzenean eta edizio maila minimo bat eskaintzen du.
Datuak gordetzeko momentuan GPX-ean gorde daitezke.

Esan bezala, GPX formatuan ditugun GPS arrastoak zuzenean JOSMrekin zabaldu daitezke,
File -> Open aukeran klik eginez gero. Horrek GPS arrastoak pantailan aurkezten dizkigu,
eta hortik aurrera, erraza izango da gainetik editatzea.
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Yahooren irudi pluginaren ezarpena

Pasa den urtetik Yahook baimena eman du beraien zenbait airetiko irudi JOSMrekin
editatzeko erabili ditzagun. Kontutan izan behar da aireko irudiek ere egile eskubideak
dituztela. Yahooren kasuan hau ez da arazoa eta JOSMek dakarren aukera honekin asko
erraztu da mapen edizioa.

Baina hau egin ahal izateko, dagokion plugina aktibatu beharko dugu. Horretarako, nahikoa
izango da Edit -> Preferences eta hor pluginen sailean sartzea. Pluginen zerrenda
deskargatu eta YWMS eta WMS pluginak aktibatu beharko ditugu. JOSM itxi eta berriz
zabaldu beharko dugu ondoren, pluginak aktibatu daitezen.

Plugin hauekin ibili ahal izateko Firefox 2 nabigatzailea beharko dugu (dokumentu hau
idazten dugun unean oraindik ez dabil Firefox 3arekin).

Behin plugina martxan dugula, berriz ere hobespenetan sartu eta Yahooren hobespenen
atalean sartuko gara. Han Firefox-en profil berri bat sortuko dugu, irudiak deskargatu ditzan.
Horretarako, jarri adibidez josm profilaren izena eta Create botoian klik egin. Zuzenean
Firefox zabalduko zaigu eta baimen bat eman beharko dugu. Itxi nabigatzailea eta prest
gaude!

Orduan, edizio gunean gaudela, nahikoa da goiko menuko WMS aukeran klik egin eta gero
Yahoo aukeratzea. Pazientzia apur bat beharko dugu baina Firefox abiarazi, irudiak
deskargatu eta JOSM barnean azalduko zaizkigu.

4.Egile eskubideen inguruan

Gai oso garrantzitsua OSMrekin editatzen hasten den edonorentzat. Kontutan izan OSM
barnean kargatzen duzun edozer ondoko lizentziapean izango dela: Creative Commons BY-
SA 2.0 edo beste modu batetara esanda:

Aske zara:
- lan hau kopiatu, banatu eta jendaurrean hedatzeko
« lan eratorriak egiteko

Baldintza hauetan:

« Aitortu. Lanaren kredituak aitortu behar dituzu, egileak edo baimendunak
zehaztutako eran (baina ez aditzera emanez haien babesa duzunik edo haiek
obraren erabilera hori babesten dutenik).

+ Partekatu baimen beraren arabera. Lan hau aldatzen baldin baduzu, edo
lan eratorri bat sortzen baduzu, sortutako lana banatu dezakezu soil-soilik
baimen honen berdi-berdineko baten mende.

Honek esan nahi du datuak kargatzeko erabiltzen ditugun moduak garrantzia dutela. Ezin
dugu Copyright pean dagoen edozein eduki kopiatu edo aireko irudiak erabili gainetik
marrazteko.

OSMen kargatzen dugun informazio guztia guk geuk tokian jasotakoa edo berez dakiguna
izan beharko du. Salbuespen bat badago: edozein motatako legedi ofizial copyright-etik
kanpo gelditzen denez, lege batean kale izenak publikatzen badira, erabili daitezke.

Kontutan izan Yahooren kasua berezia dela eta baimena eman dutela edukiok kargatzeko,
ez erabili beste iturriak modu berean beraz, ez badugu dominio publikokoak edo libreak
direnaren ziurtasunik.



